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17 
SUMMARY: 18 
Physical modeling of microscopic systems can bring insights that are difficult to gain by other 19 
means. To facilitate the construction of physical molecular models, we demonstrate how 3D 20 
printing can be used to assemble functional macroscopic models that capture qualities of 21 
molecular systems in a tactile way. 22 

23 
ABSTRACT: 24 
With the growth in accessibility of 3D printing, there has been a growing application of and 25 
interest in additive manufacturing processes in chemical laboratories and chemical education. 26 
Building on the long and successful history of physical modeling of molecular systems, we 27 
present select models along with a protocol to facilitate 3D printing of molecular structures that 28 
are able to do more than represent shape and connectivity. Models assembled as described 29 
incorporate dynamical aspects and degrees of freedom available to saturated hydrocarbon 30 
structures. As a representative example, cyclohexane was assembled from parts printed and 31 
finished using different thermoplastics, and the resulting models retain their functionality at a 32 
variety of scales. The resulting structures show configurational space accessibility consistent 33 
with calculations and literature, and versions of these structures can be used as aids to 34 
illustrate concepts that are difficult to convey in other ways. This exercise enables us to 35 
evaluate successful printing protocols, make practical recommendations for assembly, and 36 
outline design principles for physical modeling of molecular systems. The provided structures, 37 
procedures, and results provide a foundation for individual manufacture and exploration of 38 
molecular structure and dynamics with 3D printing. 39 

40 
INTRODUCTION: 41 
Molecular structure building has long been a critical aspect for discovery and validation of our 42 
understanding of the shape of and interactions between molecules. Physical model building 43 
was a motivating aspect in the determination of the α-helix structure in proteins by Pauling et 44 
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al.,1 the primary clathrate hydrate structures of water,2,3 and the double-helix structure of DNA 45 
by Watson and Crick.4 In James Watson's published account of the DNA structure, he details 46 
many of the struggles faced in such model building, such as wrapping copper wire around 47 
model carbon atoms to make phosphorus atoms, precariously delicate suspensions of atoms, 48 
and making cardboard cutouts of bases while waiting on tin cutouts from the machine shop.5 49 
Such struggles in model building have largely been remedied with computational modeling 50 
augmenting or entirely supplanting physical approaches, though physical models remain an 51 
essential aspect in chemical education and experimentation.6-9 52 
 53 
Since around 2010, 3D printing has seen a significant growth in adoption as a tool for creative 54 
design and manufacturing. This growth has been driven by competition and availability of a 55 
variety of Fused-Deposition Modeling (FDM) printers from a series of new companies focused 56 
on broad commercialization of the technology. With the growing accessibility, there has been a 57 
concurrent growth in application of these technologies in chemistry education and 58 
experimental laboratory settings.10-21 During this time period, both commercial and open 59 
community repositories for 3D models, such as the NIH 3D Print Exchange,22 have made model 60 
systems for 3D printing more accessible, though many of these models tend to be centered on 61 
specific target molecules and provide simple static structures with an emphasis on bond 62 
connectivity and type. More general atomic and molecular groups can enable more creative 63 
constructions,12,23 and there is a need for models that can enable general structure creation 64 
with tactile, dynamic, and force sensitive feedback for molecular structures. 65 
 66 
We present here molecular model structure components that can be readily printed and 67 
assembled to form dynamic molecular models of saturated hydrocarbons. The component 68 
structures are part of a wider kit we have developed for extension and outreach activities for 69 
our laboratory and university. The parts provided have been engineered to be printable with a 70 
variety of polymer filament types on commodity FDM 3D printers. We present model results 71 
using different polymers and finishing techniques from both single and dual extruder FDM 72 
printers. These components are scalable, enabling model manufacturing suitable for both 73 
personal investigation and demonstration in larger lecture settings. 74 
 75 
The primary aim of this report is to aid other researchers and educators in translating chemical 76 
structure details and knowledge in more physical ways with 3D printing. To this end, we 77 
highlight an example application by assembling and manipulating cyclohexane at different 78 
scales. Six-member ring system conformations are a core topic in introductory Organic 79 
Chemistry courses,24 and these conformers are a factor in the reactivity of ring and sugar 80 
structures.25-27 The printed models flexibly adopt the key ring conformers,24 and the force 81 
needed for ring interconversion pathways can be directly explored and qualitatively evaluated 82 
by hand. 83 
 84 
PROTOCOL: 85 
1. Preparation of model files for 3D printing 86 
 87 
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NOTE: The large number of 3D printers and free and commercial printing software make exact 88 
directions beyond the scope of this article. General protocol process and recommendations are 89 
provided here, with specific considerations given for representative models shown with the 90 
Simplify3D 4.1.2 software and MakerGear M2 FDM 3D printers. Dedicated manufacturer 91 
directions specific to a reader's printer and slicing software combination take precedence over 92 
the provided recommendations.  93 
 94 
1.1. Download the supplementary stereolithography (.stl) files associated with this article 95 
(Supplementary Files S1-S5). Upload these files to the computer with the slicer program. 96 
  97 
1.2. Import one of the C_atom_sp3, H_atom, or C-C_bond files into your slicer program. Use 98 
millimeter format for the units if an option is available. In Simplify3D, either click the "Import" 99 
button of the "Models" panel of the main window or select the "Import Models" command 100 
under the "File" pulldown menu. Select the appropriate model file from the resulting file 101 
browser.    102 
 103 
1.2.1. Import both H_atom_dual_bottom and H_atom_dual_top for dual extruder prints of the 104 
hydrogen atom. Align, group, and assign the component models to the relevant extruder based 105 
on the target filament color.  106 
 107 
1.3. Scale the imported model to the desired size. In Simplify3D, double-click either the 108 
graphical model in the main display or the listed model in the "Models" panel of the main 109 
window. This action opens a model editing panel that enables translation, rotation, and scaling 110 
of the target model. Representative models are presented for 50%, 100%, 200%, and 320% 111 
scale for all interconnecting parts. 112 
 113 
1.3.1. Activate support structures for C_atom_sp3 models with scales greater than 100%. 114 
Support structures can be used but are generally not necessary for all other models. 115 
 116 
1.3.2. Activate a raft or brim structure for 100% and smaller scale models. Such structures 117 
should not be necessary for most larger models as the flat base will have sufficient contact with 118 
the bed surface to remain fixed in place. Rafts help provide a well-adhered first layer for a 3D 119 
print, so if there are any difficulties in the stability of the first printed layer at any scale, 120 
activating a raft structure could lead to more successful prints at the expense of the material 121 
needed for the raft structure. 122 
 123 
1.4. Duplicate models to generate an array of models as desired by selecting the "Duplicate 124 
Models" option from the "Edit" menu of Simplify3D and entering the number of model parts in 125 
the resulting dialog box. Arrange the model(s) near the center of the build platform by clicking 126 
the "Center and Arrange" button in the "Models" panel of the main window, or by selecting the 127 
"Center and Arrange" option under the "Edit" pulldown menu. See Figure 1 for an example 128 
arrangement of six C_atom_sp3 models printed with PLA (polylactic acid). 129 
 130 
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Note: It is safest to print a single part at a time, though printing multiple small parts of the same 131 
color is usually more time-efficient. The print quality of parts in arrays is often lower because of 132 
the need for more filament retraction points between models. Array prints of models also have 133 
an increased likelihood of failure as one fallen part during printing can interfere with the 134 
printing of other parts. 135 
 136 
[Place Figure 1 here] 137 
 138 
1.5. Set the appropriate model processing settings for target prints. Simplify3D has 139 
selectable default processing settings for PLA, ABS, and other available thermoplastics when 140 
you add a new process or edit a process by respectively clicking the "Add" or the "Edit Process 141 
Settings" from the "Processes" panel of the main window. Specific adjustments and rationale 142 
for the provided molecular model parts follow.  143 
 144 
1.5.1. Set the model infill value between 15% and 25%. This will use less filament and result in 145 
lighter parts, but the final assembled structures will be strong enough to survive physical 146 
manipulation. 147 
 148 
1.5.2. Use 100% infill settings for the connector regions of C-C_bond and H_atom model parts 149 
if possible or as needed to increase the durability of connector tabs. 150 
 151 
1.5.3. Choose a print layer thickness of 0.2 mm or smaller to maintain print detail.  152 

 153 
1.5.4. Set the "First Layer Speed" to a value between 25-50% in the "Layer" tab of the process 154 
settings. A slowly printed first layer will improve adhesion to the print bed and will result in 155 
more successful overall 3D prints. 156 
 157 
1.5.5. Set the printer extruder and printer bed temperatures to values recommended for the 158 
chosen printer filament material. The provided temperatures are starting point 159 
recommendations.  160 

 161 
1.5.6. For C_atom_sp3 model parts, use two Outline/Perimeter Shells with an "Outside-In" 162 
Outline Direction to minimize print distortion at the bottom of the sphere. These options are 163 
available from the "Layer" tab of the process settings window of Simplify3D. For all other parts, 164 
the "Inside-Out" Outline Direction is recommended for a cleaner surface finish. 165 
 166 
1.5.6.1. PLA: Extruder = 215 ˚C. Bed = No heating. 167 
 168 
1.5.6.2. PETG (polyethylene terephthalate glycol-modified): Extruder = 235 ˚C. Bed = 80 ˚C. 169 

 170 
1.5.6.3. ABS (acrylonitrile butadiene styrene): Extruder = 245 ˚C. Bed = 110 ˚C. 171 

 172 
1.5.7. If performing a dual extruder print of the aligned H_atom_dual_bottom and 173 
H_atom_dual_top models, optionally turn on an "ooze shield" option. The slicer will then 174 
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generate a thin wall geometry around your model that will catch any dripping polymer from the 175 
inactive, yet still hot, extruder tip. 176 
 177 
1.6. Slice the model into print layers to generate a G-Code toolpath. In Simplify3D, click the 178 
"Prepare to Print!" button of the main window, or select the "Prepare to Print" option under 179 
the "Edit" pulldown menu. 180 

 181 
2. Preparation of the printer for printing of parts 182 
 183 
2.1. Coat the surface of the printer bed with blue painter's tape for unheated beds. Coat the 184 
surface of the printer bed with blue painter's tape and an underlayer of polyimide tape for 185 
heated beds.  186 

 187 
2.2. Apply a thin layer of glue stick to the blue painter's tape. Glue stick polymer will improve 188 
print adhesion to the bed surface. 189 

 190 
2.3. Place or close a ventilated enclosure over the printer bed. An enclosure minimizes air 191 
currents that can disturb print annealing. 192 

 193 
2.3.1. PLA: Open any/all ventilation ports as rapid cooling is preferred. Turn on a bed fan 194 
during printing if possible. 195 

 196 
2.3.2. PETG: Open a limited number of ventilation ports as gradual cooling is preferred. A bed 197 
fan is unnecessary during printing. 198 

 199 
2.3.3. ABS: Open a minimum number of ventilation ports as very gradual cooling is preferred. 200 
Turn off bed fans during printing. 201 

 202 
3. Finishing and assembly of model structures 203 
 204 
3.1. Remove parts from printer bed. In the case of heated bed prints, remove parts after the 205 
bed has cooled to avoid distorting the model during separation. 206 

 207 
3.2. Remove raft or brim structures from the base of parts if used. Rub the base of the 208 
model part with medium to fine grit sandpaper to remove any remaining attached raft 209 
filaments. 210 

 211 
3.3. Sand the base of C_atom_sp3 model parts with medium (120 grit) to very fine (320 grit) 212 
sandpaper to remove surface defects. Smooth the surface with the very fine grit sandpaper. 213 
Polish the surface to desired finish with a polishing cloth or buffer wheel at low revolution per 214 
minute setting. A Dremel tool with a 0.5-inch diameter buffer wheel set to 10,000 RPM can be 215 
used for polishing, taking care to not to overly heat the print and cause surface defects. 216 

 217 
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3.3.1. PLA: Prints typically have a slightly glossy finish following printing as shown in the panels 218 
of Figure 2. This finish is marred by coarse sanding, but the glossy finish can be restored with 219 
polishing. 220 

 221 
3.3.2. PETG: Prints typically have a slightly glossy finish that can be sanded and restored with 222 
polishing as with PLA. 223 
 224 
3.3.3. ABS: Prints typically have a matte or only marginally glossy finish following printing 225 
(Figure 3A). A high-gloss finish (Figure 3B) can be achieved by separately dipping the parts in an 226 
acetone bath for 1-2 seconds and placing them in a ventilated area until the acetone has 227 
evaporated and the surface solidified, typically 12-24 hours. 228 

 229 
CAUTION: Acetone is flammable and should be applied sparingly in a fume hood or very well-230 
ventilated area. ABS dissolves in acetone, so parts with layer separation defects due to poor 231 
annealing should not be treated with liquid acetone. Acetone will enter models through such 232 
defects and dissolve the model infill (Figure 3C). Polishing with acetone vapor is a slower 233 
process that will result in a similar effect, though safety precautions should be taken given the 234 
flammability of acetone. 235 

 236 
[Place Figure 2 here] 237 
[Place Figure 3 here] 238 
 239 
3.4. Insert connector ends of C-C_bond and H_atom model parts into sockets on 240 
C_atom_sp3 model parts according to desired bonding topology. Squeeze model parts together 241 
until an audible click is heard. Once connected, the single bond should freely rotate about this 242 
connection without falling apart.  243 

 244 
NOTE: The connection fit is tight, so this may require significant force for models with scaling 245 
greater than 100%. The provided parts are not intended to be separated after connecting them 246 
together, but they can be separated with a very significant applied force. 247 
 248 
NOTE: Rotation about a connected bond is a desired feature for the provided parts and models. 249 
Locking rotation requires an atom model (an sp2 hybridized carbon, for example) with a fixed 250 
structure in the connection socket that inserts between the spacings of the tabs on the end of 251 
the bond model.   252 
 253 
3.5. Assemble all printed parts according to the desired molecular structure. Saturate all 254 
C_atom_sp3 model parts by filling any open socket with an H_atom model part. For a ring like 255 
cyclohexane, close the ring with a C-C_bond model part between C_atom_sp3 model parts. 256 
 257 
REPRESENTATIVE RESULTS:  258 
The protocol provided covers a variety of potential options for interactive molecular model 259 
construction. As a basic and unifying example for a molecular assembly using these model 260 
parts, we have chosen to assemble interactive cyclohexane structures at a variety of scales. 261 
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Figure 2 shows the parts necessary for this structure: six C atoms, six C-C bonds, and twelve H 262 
atoms. These specific prints were crafted using both a MakerGear M2 and a MakerGear M2 263 
Dual printer. The more costly dual extruder printer enables the production of dual color 264 
components, here the two-colored hydrogen atom structures with the color change at the 265 
midpoint of the bond (Figure 2A). The mono-colored hydrogens in Figure 2B print in about 50-266 
60% less time due to the lack of an ooze shield structure and lack of polymer retractions in 267 
switching between active extruders. The assembled cyclohexane structures (Figure 2C) are 268 
functionally equivalent, though the dual extruder prints tend to look moderately more refined. 269 
 270 
The PLA models in Figure 2 have a reasonably nice finish, one that is more refined than ABS 271 
models straight off the printer (Figure 3A). Chemical treatment of ABS models with acetone 272 
gives a smooth and high gloss finish that almost gives the surface a wet look (Figure 3B). Such 273 
finishing can be troublesome, particularly if ABS models are not annealed well. Large models 274 
printed with ABS are prone to layer separation defects, this when the previous layer cools 275 
before the extruder can traverse over to lay down the next layer. It is critically important for 276 
large ABS prints that the environment around the heating bed of the printer maintain an even 277 
and warm temperature to slow this cooling rate. If a print with a layer defect is submersed in 278 
acetone, the acetone will enter the model and dissolve the interior support structure. This will 279 
collapse the model from the inside as shown in Figure 3C. 280 
 281 
A visually distinct appearance is secondary to functionality of the model structures. The 282 
connectors were designed to enable free rotation about single bonds. To test their utility in 283 
different systems, four different sets of part sizes were printed, with the carbon atom diameter 284 
running from 17.5 mm, 35 mm, 70 mm, and 112 mm. The assembled cyclohexane structures 285 
(Figure 4) were all able to flex, distort, and adopt relevant conformers in the same manner. The 286 
smallest of these models was the most prone to print flaws, making this size potentially too 287 
small and not recommended without tweaking the relative size of the parts. One of the primary 288 
benefits to the smaller prints is the speed of printing. An array of six of the smallest carbon 289 
atoms printed in around two hours, this in comparison to the 10 hours required for a single 290 
carbon atom of the largest size. While slow to print, large models are potentially more effective 291 
for communication in lecture settings where it would be difficult to see the motion of a small 292 
structure from a distance. 293 
 294 
[Place Figure 4 here] 295 
 296 
The dynamic aspect is one of the key attributes that separate these structures from other 297 
printable molecular models. Since the atoms can readily rotate relative to one another, the 298 
structures can be distorted to snap into the different representative conformers of 299 
cyclohexane. Figure 5 shows the chair, boat, and the transition state structure for 300 
interconversion between their respective configuration spaces. This transition state point has 301 
four labeled carbon atoms in a nearly planar geometry,24,28 the same transition state structure 302 
that one achieves doing B3LYP/6-311+G(2d,p) calculations.29 Following the same transition 303 
state imaginary frequency motion, slightly twisting 2 up and 3 down will snap the model into 304 
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the boat conformer landscape, while slightly twisting 2 down and 3 up will return the structure 305 
to the chair conformer. 306 
 307 
[Place Figure 5 here] 308 
 309 
The state point free energy estimates (Supplementary Table S1) from B3LYP/6-311+G(2d,p) 310 
calculations of optimized state points (Supplementary Files S6-S9) give a gap between the 311 
twist-boat and boat conformers of 0.8 kcal/mol, which is very close to thermal energy at 312 
298.15 K. This suggests that conversion between these should sample nearly freely. The gap 313 
between the chair conformer and interconversion transition state is more than ten times this 314 
value, indicating that the chair should be conformationally locked in comparison. This is 315 
illustrated in Figure 6, which shows estimated average conformer energy when each carbon 316 
atom location relative the ring plane is latitudinally projected onto a sphere over the course of 317 
a gas phase Molecular Dynamics calculation.30,31 In the chair conformer on the left, the energy 318 
is low when the carbon atoms are displaced above or below the ring plane, but it ramps up 319 
dramatically if they displace to align with the ring plane. In the boat conformer, the conformer 320 
energy is relatively low when carbons are in the ring plane (twist-boat state), and the more 321 
highly displaced boat conformer is not at a drastically higher energy. These configuration 322 
landscapes can be explored with the 3D printed cyclohexane models, with the chair conformer 323 
only being able to locally vibrate while the boat conformer can smoothly undulate from one 324 
pair of opposite carbon atoms to the next. 325 
 326 
[Place Figure 6 here] 327 
 328 
FIGURE AND TABLE LEGENDS:  329 
Figure 1: Like-colored atoms or bonds can be printed as arrays. To increase printing efficiency 330 
at a slight cost in quality, parts of like color are readily printed in arrays. Here, six PLA carbon 331 
atoms are printed together, each positioned on a small raft structure with an outlining brim 332 
structure. 333 
 334 
Figure 2: Dual extruder prints can be more visually refined. (A) Dual extruder model hydrogen 335 
atom prints are visually more cohesive than (B) all white model hydrogen atom prints. (C) When 336 
connected together to form complete cyclohexane rings, the assembled PLA models are 337 
functionally identical. 338 
 339 
Figure 3: ABS models can be chemically processed for a glossy finish. (A) ABS model prints 340 
tend to have a more diffuse or matte appearance, but (B) after chemically treating the parts 341 
with a brief dip in acetone they gain a high gloss finish. (C) If acetone enters the interior of the 342 
print through layer separation defects, the acetone will dissolve the model from the inside out, 343 
causing it to collapse. 344 
 345 
Figure 4: Models are functional at a variety of scales. To illustrate how the models can be 346 
printed for different purposes, cyclohexane models were assembled at four different scales and 347 
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all retain the same functionality. The carbon atoms of the largest are larger than a softball (112 348 
mm diameter) while the assembled cyclohexane of the smallest could fit within a softball. 349 
 350 
Figure 5: Conformers of cyclohexane are fully accessible. As the atoms can rotate about their 351 
bonds, the models can adopt the sterically locked chair and more conformationally free boat 352 
forms. The transition state between these forms involves four nearly coplanar carbon atoms in 353 
the ring. Lightly twisting 2 up with 3 down will slip the model to the boat conformer, while 354 
twisting 2 down with 3 up will return the model to the chair conformer. 355 
 356 
Figure 6: Model behavior matches calculations. In the chair and boat conformer states, the 357 
latitudinal displacement of carbon atoms about the ring plane over the course of a Molecular 358 
Dynamics calculation can be projected onto the surface of an enclosing sphere. While the chair 359 
form is most energetically stable, it is locked and can only interconvert to the inverted form by 360 
passing through a high energy transition state. Both calculations and printed model flexibility 361 
indicate that the boat and twist-boat conformers are separated by close to 1 kBT at 298.15 K, 362 
allowing nearly free latitudinal displacement of carbon atoms in this form. 363 
 364 
DISCUSSION:  365 
The primary aim of this study is to report a protocol for the crafting of dynamic molecular 366 
models with commodity 3D printers. These printers are increasingly accessible, often even free 367 
to use in libraries, schools, and other venues. Getting started involves making choices about 368 
both the models to print and the materials to use and deciding from these options may require 369 
some inspiration regarding what creative additive manufacturing can do for research and 370 
instruction. To address these issues, we provide some practical material recommendations, 371 
suggested model parts, a 3D printing protocol, and an example application, each of which 372 
warrant further discussion. 373 
 374 
There are many choices of thermoplastic for use in 3D printing. We highlight three in the 375 
presented protocol as these three materials are currently the most widely available for do-it-376 
yourself 3D printing. The choice may depend on what material is supported by an available 3D 377 
printer, for example many open access facilities will only print with PLA because of 378 
environmental constraints. PLA is a biodegradable and compostable material that has a printing 379 
protocol with mild temperature settings. Both ABS and PETG are less environmentally friendly 380 
and not generally recyclable, though PETG is based on highly recyclable polyethylene 381 
terephthalate (PET) and may eventually see wider spread reprocessing like PET. Sustainable 382 
printing practices would involve printing few parts at a time to ensure both print quality and 383 
print success, this while using as little discarded material (support structures, rafts, ooze 384 
shields, etc.) as possible. PLA can be brittle, so if available, ABS and PETG thermoplastics can 385 
result in prints that are more mechanically resilient and have improved layer adhesion, 386 
respectively. These properties could be desirable for an interactive molecular model that will 387 
see regular manipulation in a laboratory or classroom setting. 388 
 389 
The models presented here take these considerations into account, though they are firstly 390 
engineered to work together to enable dynamic molecular model construction. At the default 391 
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scale, they will assemble successfully into interactive molecular structures. They can readily be 392 
scaled up to large models, though assembly will require more force as the connection prongs 393 
are less easy to distort at larger size. In shrinking the components, a 50% reduction in size will 394 
still work with minor modifications, such as shrinking the carbon atom model to 48-49% while 395 
keeping the bond and hydrogen atom at 50% to enable tighter connections between parts in 396 
PLA prints. Models this small are more delicate and often require raft structures to successfully 397 
print, but they are still functional as dynamic molecular models. 398 
 399 
The thermoplastic material and chosen models to print are the two most critical aspects of a 3D 400 
printing protocol. The chosen thermoplastic will dictate the temperature, adhesion, annealing, 401 
and finishing considerations and options. If the available 3D printer does not have a heated 402 
bed, PLA is the only one of the presented thermoplastic choices that will print parts 403 
reproducibly. While the provided parts are designed to reproducibly print with different 404 
thermoplastics and hold up to dynamic manipulation, prints will degrade with use and crack, 405 
often between print layers, when placed under increasing stress. In such situations, it is easy 406 
and relatively cost effective to print a replacement part. 407 
 408 
The dynamic functionality of molecular assemblies printed from the provided models 409 
differentiates this work from other available and 3D printable models that primarily highlight 410 
connectivity and bonding types. The dynamical aspects are presented in small part with the 411 
example cyclohexane structure. The configuration landscape of cyclohexane is directly 412 
accessible by hand using these models, and the topologies of these landscapes are in general 413 
agreement with computational investigations. Much of this comes from a respect for the 414 
specifics of molecular geometry and degrees of freedom in these physical modeling 415 
components. In Linus Pauling's commentary on their success in discovering the structure of the 416 
α-helix,1 they claimed that their contemporaries faced difficulties coming from idealistic 417 
integral assumptions and adopting "...only a rough approximation to the requirements about 418 
interatomic distances, bond angles, and planarity of the conjugated amide group, as given by 419 
our investigations of simpler substances." More quantitative insight along these lines requires 420 
more specific detail than the considerations taken in building these model parts, but these 421 
models and recommendations provide a foundation for general interactive physical 422 
investigation of molecular systems. These models are an extension of 3D printable model kits 423 
we have been producing for research and outreach activities for several years prior to this 424 
report, and additional component parts that are compatible with both these models and the 425 
described protocol are available from the authors to enable more diverse bonding 426 
arrangements and dynamical action.  427 
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